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This guide is intended to orient users to the proper operation of the handheld XRF analyzer, and
to detail methods for analyzing archaeological materials, especially ceramics. The information
in this guide has been compiled from multiple sources supplied by Bruker, as well as
information imparted by Bruker representatives in training sessions, and Dr. Jeff Speakman,
Director of the Center for Applied Isotope Studies, University of Georgia.

All documents referenced in this guide are located in folder Basic Information on the Desktop of
XRF laptop.
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l. ANALYZER SPECIFICATIONS

The Bruker Tracer I1I-SD has an X-ray tube with a rhodium target and a silicon drift detector (Si PIN
diode). It contains no radioactive material. The Tracer II-SD operates with a resolution of 147 eV FWHM
for 5.9 keV, at 200,000 counts per second. The X-ray beam is collimated with dimensions of 4 mm x 3
mm. Spot size of analysis is approximately 10 mm in diameter. The maximum voltage is 40 keV, which is
in the soft X-ray range, and does not penetrate as deeply into objects as hard X-rays used for medical
applications.

Il SAFETY

X-rays are harmful to the human body. In order to minimize exposure during the operation of the
instrument, all safety procedures must be followed at all times. There are a number of safety resources
for the Bruker Tracer 1lI-SD. Before operating this instrument, all UNC users must:

* Read the Bruker Radiation Safety guide (on laptop),

* Complete a brief online course in analytical radiation safety through UNC
Environmental Health and Safety:
http://ehs.unc.edu/training/self-study/analytical-x-ray-training/

* Read UNC Radiation Protection Program guide for the use of X-ray devices and sign
the included operators page (in binder with laptop).

. INSTRUMENT COMPONENTS AND INVENTORY

The full handheld XRF rig consists of three main elements: the XRF analyzer, the vacuum pump, and the
laptop computer or PDA. Each user is responsible for inventorying all components before and after
instrument use. Any discrepancies or damages should be reported immediately.

A. The Bruker Tracer IlI-SD Handheld XRF Analyzer
In addition to the instrument, the case for the analyzer should also contain:

2 rechargeable battery packs,

Power cable- for directly powering the analyzer or recharging the batteries,

Beige communication cable,

Box of 4 filter slides,

Tweezers for inserting and removing filters,

Metal nose protector- to be placed on the instrument before storage and removed prior
to use,



Sample table,

Safety cap,

Folding mirror,

Plastic tabletop stand,

Replacement film windows for nose,
Instrument key

Behind the foam on the lid of the box:
User Guide,

Quick Start Guide,

Chart of Periodic Table and X-ray energies

Software discs.

B. Vacuum Pump
The vacuum pump may be plugged into the wall or run on battery power. The case for the vacuum
should also contain:
Power cable,
Replacement battery,
Battery charger,
Connecting tubing.

C. Computer

The majority of users prefer to use the instrument software provided on the laptop. Note that this
computer has not been networked to connect to the UNC network. This allows us to operate the system
without the use of passwords, and maintains data security. The computer bag will contain:

HP laptop,

Power cable,

Mouse and mouse pad,

X-ray safety binder.

D. Auxiliary Equipment

In addition to the essential components, reference materials and other equipment may be checked out
as needed. These include:

PDA and assorted PDA accessories,

Fully adjustable tripod for the analysis of large or stationary objects,

Standard reference materials as pressed powders or glass,

Additional film windows,

Sample cups and film,

Reference books and readings,

External hard drive for data backup.



V. BASIC OPERATION

A. Connecting
The Quick Start Guide may be found in the analyzer box or in Basic Information Folder.

Connecting to Computer:

The pins within the communications cable are very fragile. With the instrument resting securely on the
table, lift the flap of the communications port on the instrument. Line up the red dot on base of the port
with the red dot on the cable, and gently insert until you hear it click.

Insert the USB end of the cable in to the port labeled COMM 3. The software will not recognize the
instrument if it is plugged in to any other port.

Powering the Instrument:

Plug the instrument into a power source or insert a charged battery. Turn the key to the right. The
yellow status light should illuminate. This light indicates that the instrument is powered on, but is NOT
creating X-rays.

Once the instrument has been turned on for a day of use, leave it on. The instrument works best when
turned on regularly (approximately 1X week), but the life of the X-ray source will be shortened if turned

on and off repeatedly.

Placement and safety:

Consider the layout of your space and the movement of people when setting up the instrument for lab
use. You want to minimize the potential exposure to X-rays. The beam of the X-ray should always face
away from yourself and others. Maintain the laptop and other tools at a safe distance (see User Guide
pp. 7; 1 foot is ideal) from the base of the instrument while X-rays are being produced. If possible, set up
instrument so that the beam is directed at a wall (Figure 1).

Use the instrument with the included sample table and safety shield for small objects. The sample table
is placed on the nose of the instrument to provide a stable surface for samples. Small samples may fit
under the safety cap. This cap blocks most, but not all X-rays from escaping. It should be placed so that
the brass flange is directly over the infrared proximity sensor. If the sample is too large to fit under the
safety cap, the sample must be placed directly over both the detector window and the infrared
proximity sensor.

While it is possible to block the infrared proximity sensor with a piece of opaque tape or paper instead
of the cap, this is not recommended, as it allows for increased dispersion of X-rays. Operators who
choose to circumvent this safety measure do so at their own risk.



Figure 1. Typical analyzer setup. The X-ray beam is directed towards a solid wall. The mirror to the left allows the
operator to check the X-ray light. Laptop is located one foot from the base of the analyzer.

B. S1PXRF

S1PXRF is the primary software for collecting and analyzing XRF data. This program is used to establish
instrument settings, view and export collected data, and a number of other actions, detailed below.
Once the analyzer has been connected to the computer and powered on, open S1PXRF. It will
automatically open displaying the last spectrum that was generated.

The contents of the SIPXRF window are shown below (Figure 2).

a) Start/Stop indicator. Once the Tracer instrument is connected to the computer, and key has
been turned to on, click on the red button. If a successful connection is made, the light will turn
green and the Start button will appear.

b) The name of the currently open file appears in the file field. When first opened, the window
will show the last saved or opened file. The series of buttons to the right of the Start/Stop
indicator expands, shrinks, compresses, and broadens the spectrum for easier viewing. The
house icon restores the spectrum to its original dimensions. The dropdown window removes or
adds the background or foreground spectra, if overlay has been enabled (see Spectrum Overlay
below).

¢) When the Tracer instrument is on and connected to S1PXRF, the instrument’s current tube
settings will appear.

d) The tube settings used to record the file on screen (see b above) will appear in parentheses.
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Figure 2. SIPXRF window.

e) When a file is open, or a sample is being analyzed, spectral peaks appear.

f) The data bar provides information about the spectrum. The readings are sometimes
dependent upon where on the spectrum the cursor has been placed.

g) The count rate shows the amplitude at the point where the cursor has been placed.

h) The detector temperature (in Celsius) is displayed. This setting should not change. If it does
change, the instrument may be damaged. Turn off the Tracer and contact Bruker immediately.
i) Ambient temperature (in Fahrenheit) shows the temperature internal to the Tracer. Although
variable, the temperature generally should be in a range between 70 °F to 115 °F.

j) KeV is the voltage at cursor location. The reading will change depending upon the location of
the cursor.

k) LSec is the length of time the sample was analyzed. If shooting a sample, the reading is the
real time length of analysis. When collecting a timed assay (see page 7), the label will change to
RSec and the timer will count down to zero.

I) The x-axis records energy, measured in KeV.

m) Vac shows the pressure in Torr within the nose of the instrument (between window and
detector). When under vacuum, the value should be under 10.

n) Raw and valid count rates are recorded. Generally, the ratio should be less than 3:2
(raw:valid).

o) Cursor location. Placing the arrow in the spectral display and clicking the left mouse button
will move the cursor to that location. In addition, using the <—>keys on the keyboard, the
location may be moved one channel at a time.



i) Settings

Follow the instructions in the User Guide or Quick Start Guide to set up for analysis:

1. Place sample table and safety cap on instrument nose. This contains the X-rays
that are produced at several points during setup.

2. Open Download Tab. Ensure Baud rate is set to 115200,
Ensure Port is set to COMM 3.

3. Click on red dot in upper left, to turn it green.

Open Setup Tab. Ensure Back Scatter box is unchecked.
Ensure PC Trigger box is checked.

The guide to instrument settings for analysis of specific matrices and/or elements is called Filter and
Voltage and Current Selection. Your research design and sample matrix will affect which settings you
choose. If you plan to quantify your data using an existing calibration, make sure that your settings
match the calibration settings, as detailed in Section IV.

If using a filter, unscrew the brass nut on the analyzer nose and insert filter, with the oval side facing
into the instrument. The instrument does not need to be turned off for this procedure. BEFORE USE,
ALWAYS CHECK FOR THE PRESENCE OF A FILTER.

If using a vacuum, set the vacuum upright. Connect the tubing to the pump and instrument, paying
attention to the labeled ends. Switch pump on, and ensure that the pressure reaches below 10 Torr. You
will see the window on the nose suck down into the instrument. The pressure may fluctuate a bit over
the course of the day, but should always hover below 10 Torr. Monitor throughout the day, and replace
the nose window if necessary.

In SIPXRF, Open Tube Tab.

Select KTl Tube.

Select Read.

Select the appropriate voltage and current as indicated in the guide above.

P wnN e

Pulse length and filter # do not need to be adjusted.

Voltage: the energy of the X-rays produced by the instrument is given as kiloelectron volts (kV or keV).
Adjust the voltage settings to focus on particular parts of the spectrum. In general, as atomic mass
increases, so does the voltage needed to excite that element. For example, use low voltage when
focusing on major (low-Z) elements.

Current: the flow of electron charge is given as microamps (na). A general rule of thumb is that high
density materials, such as metals, use low current. Low density matrices, such as ceramics and glass, use
high current.



In most cases, the preset options in SIPXRF will meet your needs for voltage and current. If you must
create custom settings, this is done through XRayOps (see below).

Ensure that safety cap is on the nose. Check the box for PC trigger. You should hear the click of the
analyzer and see the red light, indications that X-rays are being produced. When you close the KTl Tube
window, X-rays should stop being produced and the red light will go off. The instrument is now ready to
collect data.

ii) XRayOps:

This program allows you to manually control all the settings in the SIPXRF. In most cases, the preset
options in SIPXRF will meet your needs for voltage and current. Operate this program with EXTREME
CAUTION, as it will overwrite existing presets in SIPXRF.

Before opening XRayOps, ensure that SIPXRF is closed.
Select COMM Port 3.
Check box for high speed communications.
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Check box for Open X-ray Comm Port.
The program is now able to read the settings from the motherboard in the
analyzer itself.
Take a screenshot of the default settings and save with descriptive title.
Overwrite a setting row with the desired settings. Save settings under new file
name.
7. Close XRayOps and reopen S1PXRF.

. Select your custom voltage and current settings.
9. WHEN YOUR ANALYSIS IS COMPLETE, RETURN TO XRAYOPS AND RESTORE
DEFAULT SETTINGS.

This instrument is equipped with a 5-watt bulb. Voltage times current = watts (ex: 40 keV x 30 pa = 1.2
watts). The current and voltage product must not exceed 5 watts. In general, if using high voltage, use
low current; low voltage, high current.

iii) Analyzing Samples

Place your sample over the window. Make as close contact as you can. Ensure that IR sensor is blocked
by the sample or the safety cap. See Section V. for selecting appropriate samples.

In most instances, you will want to do a timed assay. This will ensure that all of your measurements in a
study are of a consistent length. If you wish to quantify your results in terms or parts-per-million or
weight %, ensure that your timing and all other settings match that of the standards used to create the
calibration. Full details on creating and using calibrations may be found in Section IV. In general, as the



heterogeneity of samples increases, in terms of elemental composition and matrix consistency, so
should run time.

Always select Autosave. Otherwise, you may inadvertently overwrite files. Always create .PDZ files.
Depending on the type of analysis you wish to do, you may also create .TXT and .CSV files
simultaneously. Note that you can also create these file types later, by opening a spectrum file (.PDZ)
and selecting File = Save As.

Choose your filenames carefully. They should include a code for your settings, so that they are
immediately distinguishable from other analyses. For example, if you are running separate analyses for
major elements and trace elements on the same samples, ensure that the filenames are distinct.
Additionally, it is good practice to put files for each type of analysis in a separate folder.

The instrument settings are stored as metadata in each .PDZ file; however, note that the filter
information may not be correct. The instrument can’t tell which filter you’re using- that field is
automatically populated based on the KTl Tube settings.

Once you select save, the countdown will begin and X-rays will be produced. If you have selected
multiple runs, they will automatically run- with filenames indexed, e.g., Samplel-1, Samplel-2, Samplel-
3. While samples are being run, it is important to monitor raw count rates and valid count rates. These
values appear in the data bar at the bottom of the window.

Raw Count Rate- the count of photons detected per second. For this instrument, this value should not
exceed 200,000.

Valid Count- the upper limit of detection. This value should not exceed 100,000.

If either count rate exceeds the recommended thresholds, this is an indication that the detector is being
“blinded” by too many photons. Adjust the count rate by lowering the current settings. When using a
filter, the count rates will often be in the low thousands.

iv) Interpreting Spectra

S1PXRF displays the results of as a spectrum. The x-axis is energy, represented as kiloelectron volts
(keV). The y-axis is photon counts, or intensity. The spectrum line therefore displays the counts of
photons at each energy level. When excited by X-rays, each element produces characteristic secondary
X-rays. Their energy is noted on the Periodic Table and X-ray Energies chart.

Identifying elemental peaks: The characteristic X-rays for each element will produce peaks at several
specific energy levels. These depend on which electron shell ejects an electron, and which shell gives up
an electron to fill the space (Figure 3). Elements up to and including barium will show K-alpha (denoted
as Kal) and K-beta peaks. A K-alpha peak represents photons produced when electrons move from the
L-shell into the K-shell. A K-beta peak represents photons produced when electrons move from the M-



shell into the K-shell. Elements heavier than barium will show L-shell peaks, while the heaviest elements
will show M-shell peaks. Barium and some metals will fluoresce from both their K-shell and L-shell.
Where there is spectral interference (peak overlap), this software cannot differentiate between the
overlapping elemental peaks. The user must familiarize themselves with the expected elements in their
samples, or use the Artax program outlined below to run probabilistic assessments of which elements
are present.
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In main toolbar, Select ID.

Select Elem, which will pop up a periodic table.

Select the shell you wish to search (K, L, M).

Select an element to see the location of its x-ray energy.

To leave a marker for that element, select Add. It will label only the alpha peak.
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Z+ and Z- buttons will move element by element up or down the periodic table.

Depending on your sample, there may be several peaks that are unable to be identified by SIPXRF.
These include Compton Peaks, Sum Peaks, and Escape Peaks. It is important to recognize these peaks, so
that you do not misidentify them as a nearby elemental peak.

Compton Peak- A spectral peak that reflects the presence of light elements within a sample. While
elements such as carbon and oxygen cannot be measured directly by the instrument, the Compton peak
can be viewed as a proxy for carbon density within a sample. The higher the peak, the more carbon. The
location of the Compton peak will vary, depending on the filter settings. With a filter for lighter elements
(low-Z), the peak will be between 2.5-3 keV. Under unfiltered conditions, or filtering for high-z elements,
the Compton peak will fall between 18.5-19.5. This peak typically looks distinct from elemental peaks,
being wider and flatter, sometimes with a sloping shoulder.

Sum peaks form when an element is abundant within a sample. When two photons from that element
reach the detector at the exact same time, the detector gives them a count of one, and an energy level
that is the sum of their energies. This will cause a peak to form in the spectrum that is located at 2x the
characteristic energy of the abundant element. For example, in a sample with abundant iron, the K-
alpha peak for iron will be located at 6.405 KeV, and the sum peak will be located at 12.91 KeV.



Escape peaks also form when an element is abundant within a sample. These peaks form due to the
interference of silicon fluorescence at the surface of the detector. The peaks are located on the
spectrum at: element keV-silicon keV (1.74keV). For example, in a sample high in copper, the K-alpha
peak for copper will be located at 8.046 keV, and the copper escape peak will be located at 6.306 keV
(8.046-1.74). This copper escape peak is especially important to remember, because the peak overlaps
with the iron K-alpha peak, and could be misidentified.

v) Spectrum Overlay
In SIPXRF it is possible to view two spectra at the same time.

Open or collect data on one of the spectra you wish to overlay.

From the main toolbar, select Setup.

Select Spectrum overlay. A new box will pop up.

Move A to B. The current spectrum will now be outlined in blue.

Open or collect data on new spectrum. It will appear overlaid in red outline.
The file window will now show the names of both files.

Clear Spectrum B or Move A to B as required for subsequent analyses.
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From the dropdown menu to the left of the file window you can change which
file or files you are viewing.

C. ARTAX

Artax is a program that allows for the visualization of multiple spectra, manipulations of spectra, and
returns corrected photon counts, which can be used for quantitative analyses.

i) Installation

Artax is installed on the XRF laptop. However, if you wish to conduct analysis on your own PC, copy the
folder Artax from folder Basic Information, and follow these directions.

Copy the folder ‘Artax’ directly into your C: drive.
Make your computer show invisible folders. This will vary according to your
operating system. For Windows 7: Start Menu—> Control Panel 2>
Appearance—>Folder Options=>Show Hidden files and folders.

3. Copy the Bruker-AXS folder directly into the Program Data folder on C: drive.
Within ‘Artax’ folder, select ‘Artax Best’ and then double-click on Artax.exe to
open the program. You may wish to pin this program to the taskbar or create a
shortcut on the Desktop.
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ii) Creating a Project in Artax

If you have already created and saved a project with a method and elemental peaks identified, you can
skip the following steps, and simply reopen your existing file.

Open Artax. There is no password. Click through the initial error messages.
Under Project->New Project. A directory will then open on the left side of
screen.

3. Right click on folder labeled Objects=>Add Node.

Name this node: Points. The name for this node must start with Points, but

anything else may follow.

File=>Add Spectrum. Navigate to your spectra and select all to import.

Right click on Points folder-=>Add Spectra

In main window, click on Spectrum tab. All of your spectra should appear.

© N o w

File=>Save Project As. Select a name and destination for your project.

iii) Extracting Net Photon Counts

The spectra that are generated by the XRF are directly based on the counts of photons at particular
energy levels, as measured by the X-ray detector. Within S1IPXRF it is possible to retrieve these counts at
each energy level. However, these initial values do not account for inter-elemental effects (when
spectral peaks overlap). For example, an analysis of raw photon counts would likely misidentify a
number of iron and cobalt peaks if they are both present in the sample, as the peaks for iron and cobalt
overlap. Using ARTAX, it is possible to overcome some of these confounding effects, with the Bayesian
Deconvolution process. The results will be given as Net Intensities or Net Photons, which are counts of
the area under each spectral peak, minus background, minus inter-elemental effects. Depending upon
the elements present, net photon counts should be linearly correlated to parts-per-million or weight %
values.

Bayesian Deconvolution- a probabilistic method for assessing the likelihood that a particular element is
present within the sample. While this is an automated function of Artax, it is an iterative procedure that
relies upon the user’s knowledge and judgment of their samples.

1. Find the Compton Peak. This peak is not related to a single element, rather it is
the reflection of multiple light elements. It typically does not look like other
peaks in the spectrum. It may be wider, or consist of more than one peak. For
spectra that range between 1-40 KeV, the Compton Peak will be present at
around 19 KeV.

2. Click on the approximate center of the Compton Peak. A vertical line will
appear. Then select Spectrum—> Normalize from the top menu. The spectra will
become less fuzzy.

3. Click the ‘X’ to the right of spectrum name in toolbar. All will disappear. Reopen
one spectrum by selecting it from the left menu.

11
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10.

11.

12.

13.

14.
15.

16.
17.

18.

Open the Method Editor. It is located to the left of the text box in toolbar. It
looks like a little box with red and green dots. You may also find it by navigating
to Measurement—->Method.

Type a new name into the top text box.

Do not change the Measurement Tab.

In Corrections, ensure that Escape and Background are checked. Cycles= 10. For
most spectra, Min/Max will range between 1-40 KeV. If you’re unsure. Look at
your spectra and see the min and max on the X-axis.

Click Add on the top, and then Ok on the bottom of this window.

Now the name of your method should appear to the right of the Method Editor
icon in toolbar.

Open the Periodic Table. It is just to the right of the Method name in toolbar.
This is an icon with series of vertical lines.

Click in the center of a large peak on your spectrum. You will see that at least
one option appears to the right of the periodic table. Choose the appropriate
element. In general, this will be the more common element in the list.

Click on the Bayesian Deconvolution button, located to the right of the Periodic
Table button. A blue fit line will now appear. Ensure that the line matches up
fairly well with your identified element. The Bayesian deconvolution is a
probabilistic measure of elemental identification.

Go along your spectrum and identify each peak/set of peaks. Run Bayesian
deconvolution after adding each element- ensure that the fit line
improves/matches.

Once you think you have found all of the elements, reopen Method Editor.
Under Identification tab, select Preset List. The Periodic Table will appear, as
well as a button ‘Get Elements’. Click this button and the table will populate
with the elements you’ve selected.

Select Replace and OK in Method Editor Menu.

Close this spectrum and open another. Run deconvolution. The elements should
auto-identify, and the fit line should fit well. If it does not, look for elements in
this spectrum that were not identified in the previous. Follow Steps 14-16 to
add elements to Method.

Repeat Step 17 several times, until you’re confident that your method accounts
for all elements in the samples.



iv) Exporting Data

1. To export your data as net photon counts (aka ‘net intensities’), click on Points
folder, then Analyze~>Evaluate Results.

2. When Evaluation is complete, click on Points folder, then Export=>Export
Results to Excel. Choose a file name and destination.

3. There will be an error when you go to open this file in Excel, because file was
not created in Excel. Ignore this error. The workbook will have two sheets: The
first will list your instrument settings and the second will have net intensities for
each element.

4, You may use these numbers in similar ways to ppm/wt %. As a general rule,
counts below 100 photons are considered zero. The Bayesian deconvolution has
removed inter-elemental effects (i.e., accounted for overlapping peaks of
certain elements)

v) Artax Visuals
1. To zoom into your spectrum: hold down CTRL, click and scroll in main window.
2. To undo zoom, double-click in main window.
3. To pan across spectrum, move cursor below X-axis, click and scroll.
4, Options—> Display Properties will allow you to change the background, remove

axes, etc. To create underfill, Options=>Filled Spectrum.

5. To remove the lines marking elemental peaks: Periodic Table>Uncheck ‘Lines.’
To change the color of an Element label, open periodic table, drag the desired
color over the desired element.

7. To change the color of spectrum line or fill, select the spectrum from the
dropdown list in taskbar. Click on the color box to left of name, and select
desired color.

8. To copy the spectrum into a document Export->Copy Graphic (Ctrl-C).

V. QUANTIFICATION

A. Calibrations

While visual comparisons or net photon counts may be sufficient in a variety of instances, obtaining
guantitative data as parts-per-million or weight percent, is often desired. Bruker has developed a
number of calibrations specific to certain types of matrices: obsidian, copper alloys, gold alloys,
mudrock, and others. These calibrations were created by running a number of standards, a reference
dataset, on this instrument, and calculating best-fit models that can be applied to samples of unknown
composition.
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All calibrations have been built from analyses completed on this particular instrument (T352448). The
internal geometry of each instrument is slightly different. You cannot reliably use a calibration
developed on another Bruker analyzer.

For each type of matrix there is a separate reference dataset, calibration worksheet and calibration file.
One may use a worksheet as-is, or add and subtract standards in the dataset in order to obtain a
calibration that best matches the samples you intend to quantify. It is fundamental to the calibration
process that the calibration dataset has elements in the same range of concentrations as the samples
you intend to run. The model is not able to accurately predict the concentration of elements that exceed
the known quantities in the reference dataset.

The Bruker calibration data and worksheets are found in folder T352448 on the desktop. Note that the
Excel files used to create the calibrations and to produce quantitative data have an Excel macro called
S1CalProcess, which must be enabled in order to function. To install the Excel macro, see the
instructions in Bruker CalProcess Service Bulletin in S1CalProcess folder.

For ceramics, use the calibration created by Jeff Speakman and Alice Hunt at the Center for Isotope
Studies, University of Georgia (Hunt and Speakman 2015). This calibration replaces the factory-installed
mudrock calibration advocated by Bruker. If using these data in publication, proper citation of the
calibration must be included. The calibration files may be found in the UGA Ceramics Calibration folder
on the Desktop. They are built from the Bruker S1CalProcess macro. Speakman and Hunt have tweaked
the standard settings used to collect data for ceramics. When using this ceramics calibration, follow the
settings given in Appendix.

B. Using an Existing Calibration

1. Open the Excel spreadsheet for the calibration. Resave it with a new name in
your data folder. NEVER edit the original file! Each file has worksheets that
create calibrations for major elements as well as trace.

2. Check the settings used to collect values for the reference material, found in the
PDZ Files tab. In order to use a calibration, everything must match: Time of
Assay, Voltage, Current, Vacuum, Filter. If collecting data on major and trace
elements, you will need to run each sample twice, matching the major and trace
settings for the calibration spectra.

3. Collect data on your samples.

Open the reference standards files in Artax. Identify all peaks, using Bayesian
deconvolution to confirm. Make a list of all elements- be sure to specify which
peak is identified (K-alpha, L-alpha)

5. Open spectra for your samples in Artax. Identify all peaks, using Bayesian
deconvolution to confirm. Make a list of all elements. Ideally all of the elements
for reference and samples will align. This is the goal of reference set. Note that
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if there is an element present in your samples that is not in your reference set,
you will not be able to measure that element. If you need to add additional
standards, the procedure is found in the following section.

If the reference set and your samples are in agreement, you’'re ready to
guantify. This can be done file by file in SIPXRF, or batched within the
calibration spreadsheet.

i) SIPXRF calibration:

Open desired spectrum in SIPXRF.

Setup—>Select Coef (coefficient)

Find the appropriate calibration file. Factory-installed calibrations are found in
the folder T352448 on the desktop. The calibration will have the file extension
.CFZ. You will now see the filename appears in gray on the menu bar, next to a
CONC button.

Hit CONC. A new window will appear with the values of your sample in the same
format as they were entered for the calibration spectra in the Excel file. For
example, a major element calibration will likely present major elements as oxide
weight percent, which is geology standard practice. You can check on the format
of the calibration spectra on the far right of the MaChem (or TrChem) tab of the
calibration worksheet.

Select Copy in order to paste your results into a new sheet.

If you wish to look at both trace and major elements, you will need to change
the COEF file under setup and repeat with your new spectrum.

ii) S1CalProcess calibration:

A PDF entitled Mass Calibration with step-by-step instructions and screenshots is in Calibrations folder

in Basic Information, as well as a prose list of instructions entitled S1CalProcess Quantification.

C. Adding or Removing Calibration Reference Material
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1.

Collect data on your new reference material. The data must be collected by the
same instrument on which your samples will be run. You cannot use another
instrument’s calibration spectra, as the geometry of each detector is different
and will return different values.

Open the base calibration file for your matrix type and resave with a new name.
On PDZ tab, Under Add-Ins=>S1CalProcess—>Insert PDZ. All your PDZ files must
be in the same folder.

Choose either Major Element (MAChem) or Trace Element (TRchem)
worksheet, depending on what setting you used.



10.

In Add-Ins—=>S1CalProcess—=> Select/Remove elements from calibration. Add all
elements that were identified in Artax FOR BOTH REFERENCE MATERIAL AND
SAMPLES. Remove any preexisting elements in the list that are not present in
your materials. Note that not all elements can be added (e.g., gallium). Keep
rhodium in the calibration at this point.

In Add-Ins—=>S1CalProcess=>Add/Remove chem files. ADD FILES FIRST, and do
not click “Add New Chemistry”. Then remove all unwanted chem files.

Your Chem sheet will now have a list of the reference materials, but the values
will be identical. THIS IS OKAY- IGNORE ALL VALUES BUT THOSE ON FAR RIGHT
OF SHEET. Paste in the reference values for your reference material here. You
can use either ppm or wt%.

In Add-Ins—>S1CalProcess—> Create Chem File. Make sure Compton is 19.5-22 if
in a trace mode. Default for MAchem is 2.5-3kev.

Keep the slope corrections and included elements. Go through and remove a
reference material from an element if it has a zero value, or a very high
difference. Avg. difference should be less than 5, but ideally O for each element.

C. Testing your Calibration

VI.

1.

Follow the directions above to batch create concentrations in S1CalProcess, or
individually through S1PXF. Add these values to a new spreadsheet.

Check for negative numbers. In most cases, convert to zero.

Throw out any elements with no measured results. For instance, gallium was
visible in the spectra in Artax, but there are no reference values in the reference
set. The calibration returned 0 gallium.

If you have zeros in your data, add a constant. In this case- since the range
between high and low values was very great, | used 0.0001 wt% (1ppm).
Log-transform the data.

Plot the expected values against reference values for each element. If there is
reference material that was not included in the calibration for a particular
element, you want to remove it from the plot data. Each element should show a
positive linear correlation, ideally with r’ value of 1 or close to 1. Elements that
show poor correlation should not be included in concentrations of unknowns-
they should be left in the calibration, but values not recorded.

SELECTING APPROPRIATE SAMPLES

When developing a research project with the handheld XRF analyzer, there are many considerations to

keep in mind regarding your samples.
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Your sample should be flat enough to rest firmly against the instrument
aperture. Any air space between a sample and the detector will attenuate the
signal. This is especially important for measuring the lighter Z elements using a
vacuum or helium.

Your sample should be Infinitely Thick. In terms of X-ray fluorescence, infinitely
thick means that a sample is thick enough that the X-rays penetrate without
passing all the way through the sample. The depth of penetration is referred to
as the Mass Attenuation Coefficient. The depth will vary depending on the
matrix, and the instrument settings. For analysis of trace elements in silicates,
approximately 3.5mm or greater is considered infinitely thick. For a more
complete discussion of mass attenuation, see Physics folder in Basic
Information.

Surface condition matters. While the X-rays do penetrate into the sample,
surface contaminants will muddy the signal. This is especially a concern for
porous items like ceramics. If possible, use a freshly broken surface or abrade a
surface with a tungsten carbide or silicon carbide bit to reveal a fresh surface
without surface contaminants, paints, glazes, etc. Rinse with deionized water
and allow to air dry.

Be mindful of sharp points or edges. The window covering the nose of the
instrument is very thin, and tears easily. While a broken window can continue to
be used without a vacuum, it will have to be replaced for vacuum or helium
flow. Windows are expensive to replace.

Powdered samples should be as homogenous and densely packed as possible.
Ideally all powders should be pressed into pellets. Sample cups with oven dried
and firmly packed powder may be substituted, but the signal will be
substantially weaker due to the interference of the sample cup film and the
larger pore space of the sample.



Appendix. University of Georgia Ceramic Calibration Settings

For Trace Elements (Mn-Nb):
Green Filter
No Vacuum
Voltage: 40 keV
Current: 30 pa
Sample Run Time: 200 seconds
Sample Name Prefix: TR

For Major Elements (Al-Zn):
No Filter
Vacuum
Voltage: 15keV
Current: 25 pa
Sample Run Time: 200 seconds
Sample Name Prefix: V

For Major Elements (Al-Zn) +Mg:
No Filter
Helium Flow*
Voltage: 15 keV
Current: 25 pa
Sample Run Time: 200 seconds
Sample Name Prefix: He

Create a helium flow for measuring magnesium by attaching a helium tank.

1. Carefully puncture the window film on the nose without damaging the metal
screen.

2. Attach tygon tubing (or other flexible, non-contaminating tubing) to the helium
tank.

3. Open helium flow. Keep flow pretty low. You should not be able to hear it, and
barely feel it.

Plug the other end of the tubing directly onto the vacuum port on instrument.

5. Operate normally.
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